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1. INTRODUCTION

The MR3000 is a new family of compact vibration and motion measurement system. As such it
meets all user expectations in a state-of-the-art device and thus is a highly reliable and efficient
instrument for various application fields.

The MR3000 is equipped with a newest generation of electronic components, which allows a strong
reduction in power consumption while increasing the computing power. The MR3000 keeps the
best  features  of  the  current  family  of  recorders  MR2002,  with  many  new  features,  namely  a
reduced size and lighter weight, high-speed communication (Ethernet  and Wi-Fi) and an integrated
GSM/GPRS device (optional). 

On the firmware side, the MR3000 has a built-in FTP-client (to push the data to a FTP server), a
built-in SFTP-server (to retrieve the data in interactive mode) and a built-in Web server to configure
the device via the WebUI (=Web based user interface).

No special hardware or software is needed to communicate with the MR3000 – any device with a
Web browser and Internet connectivity (such as Smartphones, Tablet-PCs or Laptop-PC) will do
the job. The user can set-up the unit, download files via any type of network connection (wired,
wireless or packet data service of a GSM / UMTS network ). The famous alerting feature of the
MR2002 has been enhanced – alarm messages can be sent as text-message (SMS) or E-Mail.

The memory  storage capacity  has been increased using off-the-shelf  SD-Flashcard.  The data-
storage is managed by a file-system.

The  MR3000  systems  are  pre-configured  for  the  use  with  internal  or  external  sensor.  The
configuration presented in this document corresponds to the former option.

The 3 orthogonally oriented sensors pick up the vibration and transform it into an electrical signal
which is proportional to velocity. The signals of the sensors are continuously digitized and stored in
the ring-buffer memory. If the vibration exceeds the threshold level (trigger criteria are fulfilled), the
contents of the ring-buffer memory is written to the internal SD-Flashcard. 

The MR3000 may optionally be equipped with an external GPS antenna for a precise timing. By
default, the internal clock is synchronized by an NTP time-server using the Internet connection.

The MR3000 is water and shock resistant.  An external  rechargeable lead-acid battery ensures
continuous operation during power interruptions. 

The  MR3000,  called  sometimes  simply  MR,  is  very  easy  to  operate  and  requires  minimal
maintenance. Routine maintenance and operation does not require a specialist. 
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1.1 Features

Major feature are:

 Compact unit with integrated sensor, digital recorder, wired and wireless connectivity

 ARM/DSP Technology 

 Removable SD-Card storage (up to 32 GB)

 Integrated Web server

 Precise timing using NTP (Network Time Protocol), GPS is optional

 Power over Ethernet (PoE, IEEE.802.3af)

 Wide dynamic range (130 dB @ 250 sps)

 Sampling rates up to 1000 Hz

 Simple installation

 Easy operation

 High reliability

 Low maintenance.

1.2 Applications

 Civil Engineering

o Industrial Vibrations

o Construction Site Monitoring

o Tunneling

o Truck and Rail Traffic

o Blasting Monitoring

o Model Verification

o Building Monitoring

o Monitoring of Structures (e.g., Dams, Bridges)

 Earthquake Engineering

o Building Monitoring

o Monitoring of Structures (e.g., Dams, Bridges)

 Geology - Soil Characterization

 Earth Science - Earthquake Monitoring
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2. HARDWARE

2.1 Mechanical Drawing – Overview

1. Fixation of mounting plate
2. Bubble level 
3. Wi-Fi antenna 
4. Knurled screw  
5. Knurled screw  - below MR
6. Mounting plate
7. Lid
8. GSM antenna.

Figure 1. Mechanical drawing 
of the MR – Top view.

3. Wi-Fi antenna 
4. Knurled screw  
5. Knurled screw  - below MR

Figure 2. Mechanical drawing 
of the MR – Side view.
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2.2 Connectors

The MR3000 provides  three rugged push-pull  connectors,  as it  is  shown in Figure 3,  namely,
Power for power supply, LAN for communication and power using PoE (Power over Ethernet), and
GPS to hook-up an external GPS antenna. The LAN port is also referred as the Ethernet port.

Figure 3. Side view of the 
MR3000 showing the three 
sockets for power, LAN and 
GPS.

2.2.1 Power

Here you connect either the external  AC/DC adapter,  the external  battery pack or the external
battery.

NOTE: There is no internal battery in the MR3000.

2.2.2 LAN

Here you connect the Ethernet cable (wired communication via router or direct connection to your
PC)  – for  further  detail  check  chapter  3.1.2 and  3.1.3.  The MR3000  interfaces  to a  standard
10/100-BASE LAN.

If you hook-up the MR3000 to a router with PoE (Power over Ethernet), the MR is powered over
this connection and no additional supply power is needed. You may however connect an additional
power source for redundancy.

2.2.3 GPS

Here you connect to an appropriate GPS module for time synchronization. 
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2.3 Display (LCD)

On the LCD the MR3000 shows the most important settings and connectivity parameters.  This
feature is not yet fully functional – only the most important parameters are shown.

2.4 Status LEDs

There are three status LEDs. The full functionality has not yet been implemented.

2.5 Opening the Lid

WARNING - Static Electricity

The MR3000 contains CMOS devices and when serviced, care must be taken to prevent damage
due to static electricity.  Disconnect DC supply power before opening the MR housing.

2.5.1 GSM module

The MR3000 may be optionally equipped with a GSM device – covering GPRS, EDGE and UMTS
standard. This device is used to establish communication if the MR is out in the field. The device
replaces the Red Alert on the MR2000 series.

To use the GSM module you have to insert a SIM card in the MR.
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Figure 4. Inserting a SIM card 
in the MR.

The procedure is quite simple:

 Ensure the MR is turned off.

 Unscrew and open the lid.

 Pull out the SIM card tray by pushing the button at the left side.

 Insert a SIM card in the tray, and put the tray back in its place.

2.5.2 SD-card

The  MR3000  contains  an  SD-card  slot.  The  SD-Flashcard  in  this  slot  is  used  to  store  the
recordings. To remove the card, you have to push it down, it will then pop up.

NOTE: Ensure the MR is turned off before removing and re-inserting the SD-Flashcard. 
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Inserting the SD-Flashcard in the card-reader of your PC allows you a fast access to all the data of
the MR3000. If you have copied all the data, you can format the SD-Flashcard on your PC.

2.5.3 Internal backup-battery

The MR is equipped with a real-time clock with back-up battery. Even if the MR is switched off, the
clock continues working.
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Figure 6 The internal Lithium 
battery is located on the main 
board (at the lower right end). 
Replacement by the user is 
possible without any special 
tools.

NOTE: Do not touch the new battery with your hands!

2.5.4 Velocity Sensor

By default, the MR3000C is equipped with an internal velocity sensor.

 

Figure 7 The internal triaxial 
velocity sensor is located at the
rear end of the housing.
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2.6 Battery pack (optional)

External lead-acid gel cell 5 Ah with integrated battery charger: AC 90-264 V / 47-63 Hz.

 

Figure 8 The external battery 
pack with integrated charger
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3. SET-UP of the MR3000

Connect a power source to the MR3000 (Battery pack, AC/DC converter to the power socket or a
PoE source to the LAN socket). 

All 3 LEDs (green, yellow, red) are on and the 1st and 3rd line of the LCD become black during start-
up of the MR3000.  Then all  the 3 LEDs go off.  The green LED is blinking while the MR3000
updates the database of the files on the SD card

Once  the  unit  is  started,  only  the  green  POWER  LED  remains  on.  Now  you  can  establish
communication with the MR3000 using any of the 3 methods described below. 

3.1 Connecting to the MR3000 for the first time (direct connection)

To communicate with the MR3000 you do not need any special software – any Web browser will do
the  job.  We  assume  that  the  MR3000  is  in  our  workshop  and  we  would  like  to  set-up  the
parameters for later field use. There are 3 methods for direct connection:

 Wireless (Wi-Fi): You can establish connection using your PC or your smartphone. This
method is intended to set-up the parameters or to look at some files if you are out in the
field. You don’t need a cable to talk to the MR3000. The disadvantage is that you can only
talk to a single MR3000 at a time.

 Wired  connection  (via  router):  This  method  offers  the  most  possibilities  and  needs  no
configuration at start-up, but you need a router. If the router has access to the Internet, you
can do everything with your MR3000, including firmware upgrades. If you have a router with
PoE (Power over Ethernet) feature the MR3000 is powered through the LAN cable. You can
attach many MRs to the router and talk to all of them simultaneously. The disadvantage of
this method is that you need an additional device that you probably won’t carry out in the
field...

 Wired connection (direct): As there is no router involved you will have to adjust the network
settings of the PC. Obviously, you can talk only to one MR3000 at a time. 

Depending on the method you choose, the IP address of the MR will be different. The following
paragraphs describe these methods in detail. 

3.1.1 Wireless connection

The MR3000 acts as a Wi-Fi access point. The procedure to establish Wi-Fi connection to the MR
is the same as connecting your PC or tablet to a Wi-Fi hot-spot. Scan the available Wi-Fi networks
for  a network  named “mr3000”,  followed by  a  dash and the  serial  number.  By  default  WPA2
encryption is enabled, the password is swissmade. 

The following step by step instruction shows how to establish a Wi-Fi connection to the MR using a
WINDOWS PC or a smartphone.
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Click with the right mouse 
button on the network icon on 
the lower right edge of your 
screen and select Connect to 
a network – If you are already 
connected to another network 
you will have to disconnect 
from this network first.

Select the MR3000 network 
and click connect and….

..  enter the passphrase and 
click connect
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Tap on the Settings icon and in 
the settings screen on the Wi-Fi 
field. Make sure Wi-Fi is enabled

Disconnect any existing Wi-Fi 
connection and tap on the SSID 
of the MR3000

Enter the passphrase (enable 
‘show password’) and tap on the 
connect field 

Once you have established the Wi-Fi connection you start the Web browser to talk to the MR3000.
Enter  the  IP  address  of  the  MR (always  192.168.30.1  for  the  Wi-Fi  connection)  in  the  Web-
Browser. You will then be prompted for the user name (user) and the password (serial number of
your MR, e.g. 13050130). After a successful authentication, the main page of the Start screen is
shown

First you have to 
enter user name 
and password.. if 
your credentials 
are ok...
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..you will see the 
main page of the 
Start screen

3.1.2 Wired connection via Router

Use the cable RJ45/LEMO provided with the MR (see Fig. 9, below). On the MR side, plug the
LEMO connector into the “LAN” socket. On the other side, you connect the RJ45 receptacle to one
of the LAN ports of your router. Your PC needs a connection to the same router (wired or Wi-Fi).
Make sure to disable any other LAN connections on your PC.

Figure 9. RJ45 connector 
on top, LEMO connector 
below
 

After  connecting  the  MR  to  the  router,  the  LCD  of  your  MR3000  says  Sending DHCP
requests....  After a few seconds the MR3000 shows the IP address on the LCD, e.g.  NET
192.168.1.27. This IP address has been assigned by the router.
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The DHCP feature of the router makes sure your PC has acquired an IP address in the same
subnet and communication between MR3000 and PC is possible. Now, you can simply enter the IP
address displayed on the LCD of the MR3000 in your Web browser.

We recommend you to purchase and install a router (we are using the NETGEAR WGR614 – costs
~ 35 EURO) in your workshop for the exclusive work with your MR3000.

Generally your workshop router should have the following features:

 4 or more LAN ports

 1 WAN port to have Internet access (optional, but recommended e.g. for firmware upgrades)

 DHCP  (DHCP =  Dynamic  Host  Configuration  Protocol  –  i.e.  the  router  assigns  the  IP
addresses) feature

 Wi-Fi access point (optional, but convenient, as you don’t need a wired connection to your
PC)

 PoE capabilities (optional – if the router has PoE, the MR3000 is powered over the LAN
connection and you don’t have to hook-up an additional cable for supply power).

3.1.3 Wired connection without router

If you connect the MR directly to your computer, you must then configure the IP address of your
computer. The default IP address of the MR is 192.168.1.2, and is displayed on the LCD. Therefore
you must assign a static IP address to your computer, on the same sub-network as the MR. For
example, 192.168.1.3.

3.2 Connecting to the MR3000 in the field (remote connection)

For a remote connection (from your office to the MR at site) you need Internet access and you have
to enable the OpenVPN or DDNS service. For the Internet access you have two choices:

You can use an existing Internet access point at site (DSL or cable TV line) and you simply connect
the MR3000 with the router using the LAN cable – as you would do in your office. If the router has
the DHCP feature enabled – and you have enabled it in the MR as well, the router will assign an IP
address to the MR. You may check the Internet connectivity with the PING feature (see chapter
4.3.12).  The use of a Wi-Fi hotspot is NOT possible.

In most cases there is no such infrastructure available at site and you will have to use the packet
data service of a GSM or UMTS network (GPRS/EDGE or HSPA) to access the Internet. (see
chapter 4.3.5).
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As the MR is not accessible through the real IP address in both cases you will have to enable the
DDNS or  the OpenVPN service to communicate  to your  MR through the WebUI.  To establish
communication  with  the  MR3000  you  have  to  enter  the  Domain  Name (DDNS)  or  the  virtual
address (OpenVPN) in the Web browser. For OpenVPN you have to install the OpenVPN client on
your PC (or smartphone) with the appropriate certificates, as well. To communicate with the MR,
you have to start the VPN service on the PC. For installation of the VPN client on your PC, please
check the corresponding application note.
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4. The Web User Interface (WebUI)

Once the connection with the MR is established, and the IP address of the MR is known, opening
the Web user interface (WebUI) is quite easy. Just launch your favorite Web browser, and enter the
IP address of the MR in the address bar. Depending on your Web browser, you may have to enter
the letters “http://” before the IP address.

You are prompted for the Login / password. By default the Login is user and the password is the
serialnumber of the MR – as shown on the housing.

The interface is divided in 6 main tabs:

 Start allows you to configure all parameters related to recording and allows you to easily
retrieve the most recently recorded files.

 Status displays status information.

 System allows you to configure the interfaces, and some services related to it. 

 User  Parameters  contains  the  parameters  related  to  alarms  and  alerting  and  other
general parameters not related to recording.

 View allows a  real-time graphical  display  of  the  waveform data  or  the  vibration  level
(background recording)

 Recording List shows the content of the memory card with all the recorded events. Here
you may select files for immediate download.

After you modified some settings on a page, you can:

 Click Apply to validate your changes. It means that the content of the page is sent to the
MR, which will restart all services accordingly.

 Click Restore if you want to discard your changes.

NOTE: If you don't click Apply and leave the tab, your changes are lost.

4.1 Start

In this part you will find all the settings related to data acquisition and recording. When we speak
about “signal” in this chapter, it actually means “the signal coming from the sensor”.
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4.1.1 Manual recording

You can start recording an event by clicking on the start button, and stop the recording with stop.
When the MR is recording, the yellow LED turns on. The current recording status and the recording
duration are shown.

In the table Recording list below all recordings currently stored on the SD-card are shown. New
files show up after clicking on the refresh icon. Double-clicking on a file starts the download of the
file and the waveform is shown using the PC software EAWlight (only available for WINDOWS
PCs). You may select one or many files for download and further analysis on the PC.

4.1.2 Trigger recording

The trigger is a feature that allows the MR to start recording if the signal reaches the threshold
level. In this case the MR is “triggered”. When the signal comes back below the threshold level, the
trigger is “idle” – see section Activity on the Status screen.

You can disable the threshold trigger if you just want to do some manual or timed recording. For a
normal construction site or blasting monitoring the trigger must be Enabled.

In the Time section you can set-up the duration of the recording

 With the Pre-event time, you set-up how long you want to record before the MR is triggered.
You can record up to 20 seconds backward.

 With the Post-event, you set-up how long you want to continue recording after the trigger
has become idle. If the MR is triggered again during the post-event time, the post-event
countdown will restart from the beginning and the MR keeps on recording in the same file.

 The Maximum length setting allows you to choose the maximum length of an event file. If
this limit is reached, the MR closes the file. If the MR is still triggered it will start recording a
new file.

NOTE: The Maximum length is an important setting for the alerting service – see chapter
4.4.2

Each channel (X,Y horizontal and Z vertical) has its own trigger threshold level that is set-up in the
section  Level.  If  the  vibration  exceeds  the  threshold  level  on  a  specific  channel,  the  trigger
condition becomes true for this channel. 

In the section  Combination you choose which channels are needed to fulfill the general trigger
condition and subsequently lead the instrument to start recording. You may consider only 1 axis
(=channel, e.g. Z vertical), or more. If you consider more than one Axes, you can decide if the MR
is triggered when all the axes are above the level, or just one of them. You choose it with the
AND/OR  Logic. A common setting is to consider all 3 axes, and trigger when any of them has
reached the trigger level (“OR”)

Trigger corresponds to the menu Parameter > Triggered Recording.
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4.1.3 Timed recording

In the section timed recording you can set-up a timetable to record files automatically (in addition or
independent of the trigger). You set-up a Starting time (can be on a single point of time a repeated
start time), e.g. every Monday at 10 am. The expert mode provides you with the features of CRON
(as it is known on LINUX systems) to set-up the start time.

At the start time, the MR starts recording according to the settings in the Parameter section. Every
Period between recordings starts with a recording of Recording duration. The rest of the period,
the MR is idle. Number of recordings tells the MR how often this procedure will be repeated.

The start / stop recording corresponds to the menu Operate > Recording Mode (Keyboard trigger)
and the  Start/Stop  buttons  in  the  control  panel.  Timed  recording  corresponds  to  Parameter  >
Timed Recording.

4.1.4 Background recording

In background recording mode the MR records the peak values within a given time window. Please
note  that  event  recording  is  not  affected  by  the  peak  recording  –  both  services  may  run
simultaneously.

In the field Mode you choose what kind of peaks should be recorded:

 VM Peak is the maximum value of the signal during each period (as defined below).

 VM Peak + Vector SUM includes the maximum of the vector sum of the 3 channels 

 KBFTi represents the maximum of the moving average of the weighted vibration severity
during each period (by default 30 seconds) according to DIN 4150 part 2.

You have to set-up the Period and the total  Duration of a file. For verification purposes, the MR
shows the number of periods in one file of the given duration as Number of samples in file.

Background corresponds to the menu Parameter > Background Recording. For the MR2000 you
have  to  set-up  period  length  and  number  of  periods  in  a  file.  The  corresponding  duration  is
calculated and shown for verification purposes.

4.2 Status

This page displays information about the MR. The page is updated automatically.

 ID contains the name of the MR, followed by a dash and its serial number, and the firmware
version. You may change the ID, according to your needs. 

 LAN displays the IP address of the MR on the Ethernet port, and the MAC address of the
interface.

 Clock displays the current time and date on the MR. Don't forget to click on refresh if you
want to see the time incrementing.
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 Sensor tells you for which sensor the MR is configured. The 100 mm/s if full scale

 Wi-Fi shows the Wi-Fi status, the IP and MAC address of the interface.

 SD-Card shows the total size and the free size on the SD-Card. It also shows the number of
events on the MR.

 Activity reports the current activity of the data acquisition services: 

Trigger shows 3 different states: 

o idle: the MR is not recording an event

o recording: the MR is currently recording an event

o triggering: one of the trigger conditions is fullfiled and the MR is recording until the
post-event time is elapsed.

Background: this shows if the MR is currently recording a peak file (file name) or not (idle).

FTP backup: shows 4 different states:

o in progress: currently a file is sent to the FTP server

o errors: errors occurred when communicating to the FTP server

o idle: service is active, but there is no new file to be copied.

o disabled: service is not active

FTP push: shows 4 different states:

o Pushing N files: after starting the service the number of files to be sent is shown

o N files pending: N files are waiting to be sent in case of trouble or many files have
been  recorded  recently  and  have  not  been  transferred  yet,  eg.  due  to  slow
communication

o idle: service is active, but no scheduled push is currently going on

o disabled: service is not active

Timed recordings: shows 3 different states:

o active:  the  MR  is  either  recording  (see  trigger  status  above)  of  in  the  period
between two scheduled recordings

o idle: service is active, but start time has not been reached yet

o disabled: service is not active

 Mobile shows the status of the GSM (to send SMS) and GPRS (to communicate with the
MR)  connection.  In  case  the  connection  is  enabled,  the  GSM operator  and  the  signal
strength is shown. 
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 Indicators shows the current input voltage and the temperature inside the MR

 Dynamic DNS shows 5 different states:

o up: service is active

o starting: service is starting up

o error_server: communication problem with the server

o updated: the service has updated the DNS address. In this case an additional field
with the WAN address that is related to the DNS entry is shown

o down: service is not active

 OpenVPN gives the status and the IP address of the Virtual Private Network.

4.3 System

In this part, you find all the settings of the different hardware interfaces and software services of the
MR3000.

4.3.1 SD-Card

Shows the size of the memory card and the amount of memory used. You can format the memory
card – this erases ALL data on the card. A dialog box pops up and ask for confirmation and the
user password (see chapter) .  

Wait until the formatting is done – takes approx. 10 seconds.

4.3.2 Time

In this tab you configure the timing services of the MR. In the Timezone section you can choose
whether you prefer the MR to work with UTC time, or local time. This only makes sense if you have
activated time synchronization.

In the Time synchronization section you activate the synchronization with an external source.

 Disabled means that you don't need continuous synchronization. The internal clock keeps
the time even when the unit is powered off. However, electronics component involved in
timekeeping always have a drift, depending on unpredictable factors like temperature. As a
consequence, the MR will slowly drift away from the right time.

You may adjust the clock at once with an NTP server using the Internet connection. In the
pop-up windows you have to set-up appropriate NTP servers. 

Alternatively you can set the time manually, which is not very handy and accurate, but works
in every situation (i.e. without connection to the Internet). 
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 Network (NTP) means that the clock will  continuously be synchronized using the Internet
connection. You can specify 1 up to 4 NTP servers. The more servers are used, the better
precision you'll get. 

It takes a variable time period - depending on the difference of the internal clock and the
accurate time - to synchronize the clock once a valid NTP server is set-up and Internet
connectivity  is  available.  If  the  synchronization  was  successful,  the  time  of  the
synchronization is shown as Last clock update in the Status section.

The accuracy of the synchronization depends on the quality of the Internet connection, and
also of the servers you choose. The closer you are to the servers, the better precision you
get. The typical accuracy on the Internet ranges from about 5ms to 100ms, possibly varying
with network delays. 

The  4  default  servers  (0.pool.ntp.org,  1.pool.ntp.org and  so  on)  are  in  fact  4  servers
randomly picked up around the world. It always works, but if you want a better accuracy,
you should  put  in  these fields  servers from your  country.  For  example,  if  the MR is  in
Switzerland, you should set the 4 servers to 0.ch.pool.ntp.org, 1.ch.pool.ntp.org and so on.
It will pick up 4 servers randomly in Switzerland.

You can find more information about the NTP servers available in your country on the Web
site pool.ntp.org. 

 If you ordered the GPS option with your MR, you need to select that. Then the MR will keep
its time synchronized with the GPS time, the accuracy being around 1ms.

4.3.3 LAN    

In this tab are the settings for the Ethernet port (interface for wired connection).

Mode is as follows:

 DHCP means that the MR will try to get an IP address by sending DHCP requests. Select
this option if  you connect the MR to a network with a DHCP server.  For example, your
company network, or any network with a router.  All  settings for  the LAN connection are
made by the DHCP server and no further configuration is needed.

If  this network provides Internet  access, the MR will  be connected to Internet.  You can
check that with the ping button (see chapter 4.3.12). 

If  the  MR  fails  to  receive  a  reply  of  the  DHCP  request,  the  settings  for  the  Static
configuration are used if the case Fallback to static IP if DHCP fails is checked.

 Static means that the MR will use the static IP address provided below. You should select
this option if :

o you  plug  the  MR  directly  to  your  computer.  You  also  need  to  configure  your
computer accordingly, i.e. assign an different IP address from the same range and
the same netmask.
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o you plug the MR to a network without DHCP server.

In static mode, you must configure all the parameters manually - to do so you will probably
need the assistance of your IT support. 

If you plugged the MR directly to your computer,  only the  IP address is relevant. If you
plugged it to a network, you must fill all the parameters if you want the MR to be able to
reach Internet. 

The most important setting is the IP address that you want to give to the MR. It should be a
private address within one of the following ranges: 

o 192.168.0.0 to 192.168.255.255

o 172.16.0.0 to 172.31.255.255

o 10.0.0.0 to 10.255.255.255

The Netmask is 255.255.255.0 by default, and should remain like this except if you know
exactly what you're doing. 

The  Gateway address must be filled if you connect the MR on a network. This is the IP
address of the router.

Same thing for the Nameserver. The default is 8.8.8.8 and should work fine. 

NOTE: After you changed the IP address of the MR and clicked Apply, you're not connected
to the MR anymore. You need to enter this new IP address in the address bar of your
Web browser in order to reconnect to the WebUI. Check the LCD of the MR to know
the IP address of the MR.

4.3.4 Wi-Fi    

You can enable the Wi-Fi service and the Wi-Fi hardware by checking the Enabled checkbox.

When enabled, the MR behaves as a Wi-Fi access point. This means it broadcasts a network name
(SSID),  and you can connect  to  it  with your  Laptop  or  Smartphone.  The MR uses a static  IP
address (192.168.30.1), and will give a dynamic IP address to your Laptop/Smartphone when the
connection is established – it acts as a DHCP server.

You can configure the SSID (Service Set Identifier, it's the network name broadcasted by the MR).
If none is provided, the default SSID is “mr3000-12345678” (where 12345678 is the serial number
of the MR).

You can also configure the Channel, between 1 and 11. You can check which channels are used
by the different access points nearby, and choose the less used to have better performance.
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We recommend enabling Encryption. Do not use an open connection, as anybody could connect
to the MR3000 and tamper with the instrument. The WPA2 is the latest version of the encryption
protocol and the recommended choice. Use the WPA mode only if your computer doesn't support
the WPA2. 

Encryption  (WPA2  or  WPA)  requires  a  Password.  The  default  password  is  swissmade.  We
recommend to change this password.

4.3.5 Mobile

Use the  Enabled checkbox to enable or disable the mobile communication (GSM) interface. Be
sure to insert a SIM card in the MR before trying to bring the mobile communication to work (see
chapter 2.5.1). After you checked this field, don't forget to click on the “Apply” button. The mobile
chipset takes between 30 seconds and 1 minute to start.

The Status shows if the GSM module is currently standby (offline), connecting or on-line

If the SIM card is protected by a PIN code, you must enter it in the field. Otherwise, just leave it
blank.

The mobile communication interface offers two types of service, which are completely different and
independent.

 The SMS (Short Message Service), that is well known in the GSM networks. The telephone
number of the Center number  ( = "SMS service center") is needed to send a SMS. Most of
the time, this information is already present in the SIM card and shown here. If this is the
case you can leave this field untouched. However, if sending the SMS with the test button
fails, you may need to enter a valid number in this field. This number is provided with your
SIM card documentation. 

If you are not sure if the settings are correct or if the service is working properly, you may
send yourself an SMS using the Test SMS button

 The  GPRS  (General  Packet  Radio  Service)  allows  you  to  send  data  over  the  GSM
network. The term GPRS summarizes any mobile data service of the network – depending
on the availability this may be GPRS/EDGE or HSPA. If you wish to enable the  GPRS,
click  on the  Enabled box.  You also have to enter  the  Access point  name,  which is
provided with your SIM card documentation. Certain GSM providers require a Username
and a Password. 

If GPRS is enabled, the MR has access to the Internet. If you enabled the GPRS service, it
enables automatically the SMS service. 

NOTE: For the moment, the MR can't access the Internet through two different interfaces at
the same time. So, if you connect the MR to a network with a LAN cable, it's very
likely that the MR will have Internet access through this network (you can verify that
with the ping button, see chapter 4.3.12). If you keep it connected to the network, and
enable the GPRS service, the MR will have two ways to access the Internet: the LAN
cable  and the  GPRS.  The MR doesn't  handle  this  situation  properly.  Be sure  to
unplug the LAN cable when enabling GPRS.
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4.3.6 DDNS 

DDNS stands for Dynamic DNS, a method to update a name server in the Domain Name System.
Without going into technical details, DDNS allows you to communicate with an MR that is out in the
field where it does neither have a public (accessible from the WEB) nor a static (not changing) IP
address. The router where the MR is connected to needs a public IP address – this is the case for
most ADSL or cable TV routers you find in private houses. You have to set-up port-forwarding in
the configuration of the router to reach the MR in the network. The DDNS service makes sure that
you can access your MR through a persistent domain name (e.g. mymr.dyndns.org). 

Communication  with  the  DDNS service  needs  an  Internet  connection  –  check  with  the  PING
function as described in chapter 4.3.12.

For further details, please check the web-site of the DDNS service provider of your choice, the MR
supports the following services: 

 dyndns

 no-ip

 ovh

 dyndnsit

 changeip

 sitelutions

NOTE: DDNS services are not useful when you use GSM/GPRS networks unless yous SIM
card has a public IP adress. OpenVPN (see below, chapter  4.3.7) provides another
solution to deal with dynamic IP addresses.

4.3.7 OpenVPN

VPN stands for Virtual Private Network. With this service, you will be able to communicate with the
MR when it is out in the field where it neither has a public (accessible from the WEB) nor a static
(not  changing)  IP  address.  The OpenVPN service  makes  sure  that  you can  access  your  MR
through a persistent IP address. OpenVPN service works nicely if you attach the MR to a ADSL or
cable TV router you find in private houses. No further settings on the router (e.g. port-forwarding as
for DDNS) are required.

The VPN interface uses not the real, but a virtual IP address. This address remains always the
same (or – depending of the configuration of the OpenVPN server – the address is at least known
by the OpenVPN server) regardless of the real IP address and if the MR is connected via GPRS or
via wired connection. The virtual address is shown here and on the  Status screen in the VPN
section.

The  configuration  is  fairly  easy,  you  just  have  to  click  the  Enabled box,  then  upload  the  4
configuration files on the MR, and click on Apply. The configuration files (sometimes referred as
VPN keys) are provided by the provider of the VPN service. 
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Communication with the VPN service needs an Internet connection – check with the PING function
as described in chapter 4.3.12. The data stream for interactive communication through the WebUI
are  routed  via  the  OpenVPN  server.  The  communication  between  your  PC  and  the  MR  is
encrypted.

The other data (FTP push, NTP time synchronization, E-Mail, Firmware-upgrade) are not routed
through the VPN tunnel, but use the normal Internet access.

4.3.8 Mail

You may use e-mail instead of the SMS service. To do so you need an e-mail account and Internet
access for the MR-– check with the PING function as described in chapter 4.3.12 

You have to enter the access data of your e-mail account, i.e  User address (e-mail address of
your e-mail account) and the  Password in the section User identity. In the section SMTP server
you have to enter the URL (name or IP address of the SMTP server) and the Port. 

You don’t need a unique e-mail account for every MR - you can have one e-mail account with a
single e-mail address for  all  of your MRs as this address is only used to send e-mails,  not to
receive.

To illustrate that, let's show an example using GMAIL. If you use a different e-mail service you will
have to check the documentation of your service provider to figure out the URL and the port of the
SMTP server.

 Create an address, e.g. mr3k.syscom@gmail.com on the Gmail Web site

 Enter this address as User address together with Password in the section User identity

 The settings for the SMTP server can be found on the GMAIL site…enter  smtp.gmail.com
for the URL, 25 for the Port and enable TLS encryption. 

The quality of the mail service varies with the provider. With some providers, sending an e-mail is
almost instantaneous. With others, it takes up to one hour between the moment you send the mail,
and the moment you receive it.

4.3.9 FTP send

If this service is enabled, the MR will periodically connect to a remote FTP server and copy its data
to it. This feature has two main purposes:

 a permanent backup, your data exist both on the MR and the server.

 a way to make the MR's data easily available, as the access to the data on the server is
much faster than to retrieve the data from the MR3000.

First you have to set-up the access to your FTP server in the FTP server settings:

 Host is the URL (e.g. myftphost.com) or the IP address of your FTP server (without the ftp://
prefix). You may add a specific subdirectory to the host name (e.g. myftphost.com/mydir/mr)
in this case, the MR will create the corresponding subdirectory on the FTP server.
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 Username is your login for this server

 Password is used to authenticate the user on this server.

It is highly recommended to test your settings with the  Test FTP server button. Your MR needs
Internet access to perform the test.

The FTP send service has two options – both can be active:

 In Push mode the MR will push a new event file to the FTP server as soon as recording of
the file is done. The current background file is updated on the FTP server at least every 5
minutes.

Preserve SD-Card hierarchy means that you have the same directory structure on the FTP
server as in the MR ../events/2014/01/09/  - year,month,day and /background/2014/01 –year
month.  If  this  option  is  not  checked,  the  files are  copied  to the directories  /events  and
/background. Enable this option if both, Push mode and Backup mode are active

 In  Backup mode the MR will  keep the FTP server synchronized with its  data. At  each
connection, the MR will compare its own data to the FTP data, and any missing file on the
FTP will be copied. This option can be combined with the Push mode. It checks the integrity
of the data on the FTP server in scheduled time intervals. 

NOTE: The name of the main directory (main-dir/events/2014/…) is the Name of the MR, as
set-up in the section General of the User Parameters screen (see chapter  4.4.1). If
you change the Name, the MR will generate a new directory on the FTP server.

4.3.10 VDV Cloud

VDV  is  a  comprehensive  data  management  system  for  storing  measured  data,  offering  web
access, alarm service, reports and application specific data handling toolkits for the MR.

The MR automatically sends the data to a VDV cloud server where it can be accessed using a web
browser. This service is offered by Vistavision (http://www.vistavision.com/).

Main features :

 Free 30 days of cloud service with new MR3000

 Secure web access using a user name and password

 Access Background and Event data

 PDF Reports
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4.3.11 Authentication

Here you can change the password of the MR. The password is used for the WebUI access and for
the SFTP service (see chapter  5.3.1). By default, the password is the serial number of the MR –
shown as UID on the Status screen.

4.3.12 Upgrade

In this section, you find:

 The Ping button allows you to send a ping request to a Web site. It's useful if you want to
know whether the MR has Internet connectivity. If you can ping a well-known Web site (e.g.
wikipedia.org), if it succeeds, the Internet connection is working. 

 The Upgrade from remote server part is used to do an upgrade of the MR's firmware. The
MR needs an Internet connection for that. In order to upgrade to a new firmware, you need
to know the URL for this upgrade. This is provided by SYSCOM when a new firmware is
issued. 

Once you entered this URL in the field, click on the  Start button. Upgrade takes usually
between 1 and 2 minutes, but it can be longer if the Internet connection is slow. You should
just  be patient,  and never  turn off  the MR while  an upgrade is  in progress.  If  an error
happens, a message will be displayed on the LCD screen of the MR. 

NOTE: It is not recommended to upgrade MRs that are out in the field using a GPRS connection.

 The Upgrade from files  feature  allows to  flash a new firmware  directly  from your  PC,
without  Internet  access.  Please  contact  the  factory  to  get  the  files  and  the  necessary
instructions. 

4.3.13 Maintenance

Here you may generate a report of the system to make further investigations in case of trouble. The
report is automatically downloaded to your PC.

NOTE: The log files and other variables used to generate the Diagnostic report are in volatile
memory, do not switch of the MR before the report is generated. Make a report as
soon as a problem has been encountered. If you wait for too long time, the interesting
part of the log file might be overwritten. If the standard interface for communication is
not available, you may use the Wi-Fi access to communicate with the MR. 

The Reboot button initiates a warm start of the MR.
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4.4 User Parameters

In this part you set-up the parameters related to Alerting and the general parameters that are not
strictly related to data acquisition.

There are  references  to the  corresponding  parameters  of  the MR2000 in italic.  If  you are not
familiar with the MR2000, just skip the text in italic.

4.4.1 General

Here you can modify  the  Name  (ID) of  the MR (by default  MR3000 + serial  number)  and the
Comment string. 

 The Name is used as the root-directory for the FTP service. If the Name is changed, future
files on the FTP server will appear in the new directory. No special caracters are allowed for
the Name.

 The  Comment  string should describe the location of the MR. It is included in the alarm
messages. Special characters are allowed, but use extra space if the alarm message is sent
as SMS.

The comment field corresponds exactly to the comment filed of the MR2000, where the ID did not
exist for the MR2000.

4.4.2 Contacts

In  this  section  you  add  Contacts  for  the  alerting  service.  Contacts  are  people  who  receive
notification from the MR, depending on event recording and /or alarm threshold exceedance. To
add a new contact click on the  Add button. To edit a contact, just click the corresponding line.
Clicking the Del button will delete the corresponding contact.

After you changed anything on the contact list, don't forget to click on the Apply button.

A contact consists of a Name, a Phone number to receive a text message (SMS) and/or an E-mail
address to receive e-mails. You can select which condition will cause the delivery of a message to
this contact. If you want to send messages by e-mail you have to set-up the e-mail service (see
chapter 4.3.8), if they are sent as text messages (SMS) you have the enable the mobile services
and make sure the SMS are sent properly (see chapter 4.3.5).If you enter both, e-mail address and
phone number, the MR will send the message to both destinations.

The condition to trigger a message can either be related to Event recording or - regardless of the
recording of an event - when the vibration reaches the Alarm threshold (see chapter 4.4.3 “Alarm”,
below). The difference between the two methods is described below:

 Alerts  related  to  Event recording include additional  information,  such as Peak of  the
event, peak of the vector sum of the event and the dominant frequency of the event. To
use this option,  you have to make sure,  that  the trigger  threshold is  below the alarm
threshold. Alerts related to event recording are sent  after the event is recorded, i.e. the
vibration is again below the threshold level or the max recording time has been reached
and the post-event time is elapsed  (see chapter ….).
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Messages sent to an E-Mail address additionally include a graphical  presentation of the
waveform data (PGN graphics). The waveform data and the FFT are NOT calculated if the
duration of the event exceeds 60 seconds (@ 1000 sps sampling rate). 

 Alerts based on the Alarm threshold are independent from event recording. They are sent
immediately.

Additionally you may send a Daily Message to any of the contacts (see chapter 4.4.4)

Contacts corresponds to the tab Alerting > Phonebook combined with the tab Alerting > Conditions.
The MR2000 can send SMS type messages only - forwarding a SMS to an e-mail address is a
service offered by the GSM provider. The MR3000 has the capability to send e-mail messages
directly.

4.4.3 Alarm 

The alarm service checks if the vibration exceeds the defined alarm threshold levels. If this is the
case, the alerting service of the MR sends a SMS or e-mail notification to the persons listed in
contacts where Alarm 1 or Alarm 2 have been checked (see chapter 4.4.2). 

Alarm duration is the period between the first exceedance of the alarm threshold and the end of
the alarm condition. If the alarm threshold is still exceeded after the Alarm duration period, a next
message will be generated.

Alarm list

You can configure two different alarms (e.g. high level and low level alarm – or an alarm based on
the peak of the signal and another alarm based on the vectorsum of the signal.

The button Mode lets you select the signal used to trigger the alarm: 

 Level:   You specify a threshold level for all 3 channels. The alarm will be triggered if the
vibration on any of the channels exceeds this level. 

 VSUM: You specify a threshold level for the vectorsum of the 3 channels.

For  event  based  alerting,  the  vectorsum  VSUM  and  the  peak  values  are  calculated  for  the
corresponding event end then compared with the alarm threshold levels. Event based messages
are issued immediately after the event has been recorded (check chapter 4.1.2 for max. recording
time Max. length). 

For alarm based alerting, VSUM and the peak values are continuously compared with the alarm
threshold levels. Alarm based messages are issued immediately.

In the field Message you may add some individual text that is sent along with the alarm message
(SMS or e-mail), e.g. "Low Alarm" or "STOP the machine immediately". You may also check the
box “Add more info” to get the time and the comment 

NOTE: The  alarm  threshold  is  applicable  for  both  types  of  alerts  (i.e.  event  based  and
threshold based alarms) 
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NOTE: When adding additional  information to the SMS, be careful to not exceed the 160
character limit of the text message (SMS). If  a message exceeds 160 characters,
charges for two messages may apply.

Alarm corresponds to the menu Parameter > Triggered Recording and Parameter > Alarm. The
MR2000 has only alarms based on the waveform signal, not based on the data in the background
file (VSUM). The holding time of the MR2000 refers to the holding time of the relay. The message
is sent after an event (assuming alarm level > trigger level) has been fully recorded (i.e. vibration is
again below the threshold level or the max recording time has been reached).

4.4.4 Daily message

This service sends you a SMS or e-mail notification every day. You can set-up the Time when you
wish  to  receive  this  notification.  You  may  add  some  extra  text  in  the  Message field.  Some
information is automatically appended: the number of events and the free size on the SD-Card, and
the background mode.

The recipients of this message are set-up in the section contacts –see chapter 4.4.2

4.4.5 Acquisition 

You can choose between the pre-defined Filter types. The adequate filter for different application
is discussed in chapter 5.1. The sampling rate is adjusted accordingly. 

You may override the default setting for  Sampling rate and choose a higher sampling rate. You
may also record the unfiltered data – keep in mind that there is always an anti-aliasing filter, cutting
of the frequency contents above 80 % of Nyquist frequency (= half of the sampling rate).

NOTE: Higher sampling rates accumulate more data and create larger files.

Acquisition corresponds to the menu Operate > Choose Filtertype.

4.4.6 Recording setting 

You can choose between two file formats for Event- and Background recording:

 XMR (for event files) and BMR (for background files) is the format that was used in the
MR2002 recorder. The main advantage is that it's been around for quite a long time, and
different  software  is  available  to  view  and  analyze  these  files.  There  is  EAWLight,
available for free on SYSCOM Web site, and VIEW2002.

 ASCII is a simple format,  where all  the data recorded is put in a simple text file.  It's
convenient if you plan to use software like  Octave or  Matlab to view and process your
data.

For the Event recording you may limit the file length – often short files are easier to analyze and
they  are  for  sure  easier  to  transfer.  Individual  settings  for  triggered  and  manual  recording  is
possible.
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4.5 VIEW 

4.5.1 Acquisition 

This service provides a real-time display of the waveform data, as they are recorded if the trigger
criteria (see chapter  4.1.2) are fulfilled. The data are filtered and the sampling rate is as set in
Acquisition (see chapter 4.4.5).

Each axis is can be unselected, so that you can display only one axis if you want.

The Query refresh period is the period between two requests from your computer to the MR. If
you  set  it  to  a  small  value  (like  100ms),  the  display  is  smooth,  but  also  requires  a  fast
communication to the MR3000 (direct connection,  not via GPRS) and more CPU time on your
computer If you see that the display is slow, you should increase the query refresh period to e.g. 10
seconds.

The  Sample  grouping tells  how many samples  represent  1  pixel.  If  you  set  it  to  1,  the  line
displayed represents exactly the signal, but it also goes at the same rate. This means very fast. If
you want to have time to see what's happening, you must increase this value. As a result,  the
display is slower, and the line becomes an approximation of the signal – one pixel represents the
mean value of a group of samples – this has the same effect as applying a low-pass filter to the
signal. Behind the line, with the same color but lighter shade, the envelope of the signal (with the
true peaks) is drawn.

The Vertical zooming, or simply zoom, is exactly what its name suggests. A value of 1 means no
zooming; a value of 100 means that signal is multiplied by 100.

4.5.2 Background 

This service provides a real-time display of the vibration level of the past (background file). This
presumes that background recording is active (see chapter 4.1.4).

The settings are the same as for the waveform display (Acquisition – see above). Additionally you
can move the display with the arrows. You can see at least one day back in time, probably more. It
depends on the period you set in the background settings. The simple arrows allow you to move
forward or backward, and the double arrows send you back at the beginning or the end of the
graph.

If you're positioned at the end of the graph, it will scroll by itself when a new sample arrives.
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4.6 Recording List

On this tab you may select single files for immediate download – it is called “interactive mode”
(similar  as  VIEW  >  EVENT  for  the  MR2002).  All  the  files  in  the  memory  are  presented  in
chronological order (default). You may change the sorting order by clicking on the corresponding
column title. For each file the Peak values, the recording Duration, the file Type and the Reason
for the recording are shown. 

Use the arrow keys << >>  at the upper right edge to go to the first / last page, the simple arrows <
> go the the next/previous page.

If you move the mouse over a single line, additional detail information for this file is shown. Clicking
on the line will  start  an immediate download of the file.  If  you have EAWlight  (the WINDOWS
software to visualize the data) installed, the file (peak or event) is shown immediately. You may use
EAWlight to perform a Frequency Analysis (FFT) of the waveform and to print the waveform.

You may select several files and then click on the  Download button. The files are packed in a
single Zip-File and transferred to the PC. The Zip-File is stored in the DOWNLOAD directory of the
PC.

A more sophisticated method is to enable the Filter and to click on the Add button. You may then
select all the files matching certain criteria (e.g. all the files that have been recorded since a specific
date). You may use more than one line to narrow down your selection. 

NOTE: We recommend to erase the SD-card at the beginning of the measurements at a specific
location and to keep all the files on the SD-card throughout the whole monitoring period. In order to
have seamless (without any interruption) recordings (peak files if the vibration level was below the
trigger  threshold  or  additionally  event  files  if  the  vibration  level  exceeds  the  trigger  threshold)
throughout the whole monitoring period, it is NOT possible to erase single files. The SD-card is
considered as documentary evidence.
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5. OPERATING THE MR3000

In this section some aspects of the work with the MR3000 are described in detail

5.1 Preparing the MR for field use

We recommend to set-up the MR3000 in the office for  the use in the field.  Depending on the
measurement task, you may consider the different power options. 

For a long-term installation you may check the availability of an existing Internet connection you
may share (e.g. you can easily hook-up your MR3000 to a ADSL or cable TV router). If you plan to
use a GPRS connection we recommend you to check the network coverage at the site, maybe an
antenna with extension lead may be needed.

We recommend you to clear any obsolete files on the SD card before you use the MR for a specific
measurement.  And we also  recommend  you to  collect  all  the  data  once the  measurement  is
finished.

5.1.1 Construction site monitoring

For the monitoring of a construction site we need 4-5 MR3000 to equip all the nearby buildings. We
do not know if we can use an existing Internet connection, so we use MRs with the GPRS option
and equip the units with a SIM card (see chapter  2.5.1). AC power is available at all the sites –
nevertheless we use the external battery pack in order to be warned if  somebody unplugs the
device – if we had no battery pack, the unit is dead if the mains is disconnected.

First we set-up all the communication parameters, to make sure that we are able to communicate
with our MR once it is installed in the field.

We establish communication to the devices – as described in chapter 3.1 and set-up the units as
follows.
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We set-up and activate the
SMS (for the Alarm 
notification) and the GPRS
service to have Internet 
access.
To make sure the SMS 
service is configured 
properly, we send a test 
SMS to ourselves
If this fails, we may have 
to add the number of the 
SMS service center – see 
chapter 4.3.5

We need the possibility to 
communicate with the unit,
as we may have to change
the trigger level or we 
have to adjust the alarm 
scheme (add a person to 
the contacts, change a 
threshold level, a.s.o.) To 
do so, we enable the 
OpenVPN service.

14111000_MR3000-4.39.odt  printed: 03/01/14  subject to technical change without notice



SYSCOM

We need the data on our 
server immediately to be 
prepared if we have to 
answer a question about 
the current vibration level 
and the severity of the 
most recent events. 
The FTP push service 
makes sure we have the 
files on our server. The file
of the background data is 
updated on the server

As we have a permanent 
Internet connection we 
activate the time 
synchronization service 
over the network to have 
accurate timing.

We have now set-up  all  the  relevant  parameters  for  communication  (for  rental  units  all  these
settings have been made by the rental service provider). It is a good practice to set-up sensible
parameters for recording as well.
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A bandwidth of 1-156 Hz 
filter covers most needs 
and the sampling rate of 
400 sps is adequate.
For the monitoring of 
railway vibration we select 
1-315 Hz and 800 sps.

We need the alarm 
notification. We will send a
SMS to the site supervisor
if the vibration is close to 
the limit value given in the 
code – of course we add 
our phone number to the 
list of recipients as well. 

14111000_MR3000-4.39.odt  printed: 03/01/14  subject to technical change without notice



SYSCOM

We activate the daily 
message to have a sign of
life of the instrument every
day.

We set-up a trigger level 
of 1 mm/s on all 3 axis and
enable any of the 3 axis to
trigger the unit. 
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In addition to that we also 
activate the background 
recording, this is to have 
evidence that the unit was 
in operation all the time 
even if the vibration is 
always below the 
threshold value.

Last but not least we have 
to take care of the alarm 
parameters. We have set-
up a threshold level of 6 
mm/s on all 3 axis in the 
first step. 
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We need an alarm on the 
vectorsum as well...

Now we install the units at site. We choose a convenient place where we have an AC outlet nearby
and reasonably good GSM/UMTS coverage. We level the unit and connect power. Once the unit is
started up we use our smartphone to make a final check before we leave the place. To do so we
use the Wi-Fi access (for details see chapter 3.1.1)
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We open the Status 
tab and check 

1. the status of the 
Mobile connection. 
We see that the status
is up - even if the 
signal is weak - and 
that the MR has a 
acquired an IP 
address.

2. the status of the 
OpenVPN service. 
We see that the 
service is up and the 
MR has acquired a IP 
address.

NOTE: This is the 
address we have to 
talk to if we want to 
connect to the unit 
from our office.

Before we leave the place we shut down the Wi-Fi connection to save battery capacity and to make
sure that nobody attempts to tamper with the unit 

Now the unit is operational  and we should receive the daily message every day. Also the files
should be on our FTP server within 5 minutes. We may have to add more recipients for the SMS
messages in the contacts section.

The installation of the units in the field is a matter of 5 minutes if all the parameters have been
configured properly.

5.1.2 Single day measurement

We prepare 3 units to measure the vibration in an industrial plant. We will measure simultaneously
at 3 different spots, so we need the possibility to talk to all 3 MR3000s at the same time, e.g. to
start recording. There are 2 choices – either we use a GPRS connection (which is quite slow, but
does not need any wiring) or we take a router with us and connect the 3 units and the PC to the
router. 

We decide to have a wired connection and take our router from the workshop (see chapter 3.1.2)
with some long (up to 100 m) Ethernet-cables with us. We connect all the 3 units to our router and
make sure all 3 are accessible (the router will assign different IP addresses to them). We make
sure all 3 units are synchronized to the NTP time server.
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As power supply we take the external AC/DC converters with us. 

We erase all the data on the memory card (see chapter 4.3.1) – as we do not want to waste time to
upload obsolete files.

We decide not to work with triggered recording, but to trigger the units manually, so we disable the
trigger.  To trigger the units (almost) simultaneously we use the start recording button (see chapter
4.1.1). To do so we open an instance of our browser for each instrument and we arrange them
neatly on our desktop.

For the measurement itself we will use timed recording.

After having recorded some events we would like to have a look at the data on our PC. To do so
we will have to retrieve the data from the MR. We use our favored SFTP client to retrieve the files
and open EAWlight to visualize the files. 

5.2 Power Options

The MR3000 provides several power supply options, that is:

 12 VDC from a battery

 Syscom battery pack with internal charger

 AC/DC converter (power cube). 

 Power over Ethernet (PoE) according to IEEE 802.3af, 

or a combination of them. 

5.2.1 External 12 VDC Battery

Any 12 V battery may be used as long as it meets the capacity requirements of the application. The
battery may be charged by a solar panel with a battery charging circuit. The input voltage range of
the MR3000 is 9 V up to 13.5 V DC.

5.2.2 Battery Pack

The battery pack contains a lead acid gel battery and a battery charger. The battery capacity is 5
Ah. Depending on the hardware and services you are using, this results in an autonomy shown in
the following table:

Normal operation (LAN interface active): 25 hours
Normal operation (LAN + Wi-Fi) 21 hours
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Normal operation (LAN + Wi-Fi + GPRS idle 17 hours
Normal operation (LAN + Wi-Fi + GPRS communicating) 15 hours

Figure 10. This picture
shows the set-up of a 
MR3000 connected to 
the SYSCOM battery 
pack

5.2.3 External AC/DC Power Supply

Alternatively,  the  MR3000  may  be  powered  by  a  12  VDC  AC/DC  supply.  In  case  of  power
interruption the MR300 will shut down without any notification.
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Figure 11. This picture
shows the set-up of a 
MR3000 connected to
an external AC/DC 
battery.

5.2.4 Power over Ethernet

The MR3000 provides the option to be used as a Powered Device (PD) using Power over Ethernet
(PoE) according to IEEE 802.3af standard. An appropriate commercial/industrial PoE switch along
with a 48 VDC supply allows you  to use the LAN connector as a combined communication/power
plug. 

The PoE switch injects the 48 VDC into the data lines which are then extracted by the MR3000.
According  to  the  selected  PoE  switch,  multiple  instruments  may  be  linked  to  a  combined
communication/power network. Optionally a battery or UPS may be hooked to the PoE switch to
accommodate for power interruptions.
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Figure 12.  MR3000 
and a laptop being 
powered from a PoE 
switch, via LAN 
connectors.

5.2.5 Combined Power Options

The MR3000 may also be powered by a combination of PoE and an auxiliary external 12 VDC
supply (battery or AC/DC). The MR3000 automatically manages the power sources and switches
off PoE as soon as external 12 VDC are detected.
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5.3 Additional services

This section describes the download of files from the MR without using the interactive method in
the tab Recording List in the WebUI (see chapter 4.6)

5.3.1 Embedded SFTP server.

The MR has an embedded SFTP server that allows you to easily download events and background
files from the MR to your computer. SFTP stands for Secure File Transfer Protocol (FTP using SSH
connection). 

Do not mix up the SFTP server described here with the FTP send service described in chapter
4.3.9. FTP send pushes the files in given time intervals to a remote server, the SFTP server allows
you to interactively download the files on your PC.

To use SFTP you must install a SFTP client on your PC. Then you connect to the MR (which is the
server), and you can browse the events and background files. The login and password you need to
know are:

Login: user
Password (default): serial number of the MR

NOTE: Every SFTP client  has a refresh button  somewhere.  When you browse through the
content of the MR, and you don't see the files that are supposed to be there, just click
the refresh button.

Below you'll find a list of SFTP clients with a quick explanation on how to use it. All these software
are free, and widely available on the Internet.

5.3.1.1 FireFTP

If you are using Firefox as Web browser, this is the favored SFTP client. You have to install the
add-on FireFTP. This SFTP client is directly integrated into your Web browser.

To install it, launch Firefox, and click on Tools->Add-ons. Then choose and install FireFTP, and
restart Firefox. Then you need to add a button for a convenient access to FireFTP: just click on
View->Toolbars->Customize, find the FireFTP button, and drag/drop it to the toolbar somewhere.

Click on this button now, the FireFTP tab will appear. Select “Create an account”. 
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In the Main tab enter 
an account name 
(whatever you want to
name this connection)
In the field host you 
enter the IP address 
of the MR (real 
address for direct 
connection, VPN 
address for remote 
connection 
login and password 
as mentioned above.

Then you go to the 
Connection tab and 
choose SFTP in the 
Security drop down 
menu. All other fields 
remain blank 
There is nothing to 
edit in the Advanced 
tab.

Now click on the Connect button and the following main screen appears. On the left side you see
the file system of your PC on the right side the file system of the MR3000. On the PC you should
create a specific directory for each MR.
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To quickly retrieve ALL the data from the MR, you navigate on the left hand panel (PC) to the
directory of this MR, on the right hand panel you navigate to the directory “user”. Then you open
the menu Tools and select Sync Directories & Subdirecotries… As shown in the picture below, the
tool has already pre-selected the desired action, i.e. to Download both directories (background and
events) to the local side. By clicking the Sync button, the transfer is started. Within a few seconds
you have transferred ALL the files from the MR3000 to the local PC.

If there are new files in the MR, just sync again.

5.3.1.2 Filezilla

It's the most famous stand-alone FTP/SFTP client. You can download it at this address:

http://filezilla-project.org/download.php?type=client

The first time you launch it, click on File->Site Manager..., then click on New Site. In the host field,
enter the IP address of the MR3K. For the protocol, choose SFTP. For the logon type, choose
normal. Then, enter your login and password, and click Connect.
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5.3.1.3 WinSCP

As an alternative to Filezilla, there is WinSCP. You can get it at this address:

http://winscp.net/eng/download.php

The first time you launch it, click on the New button.
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6. Firmware history

6.1 Firmware 1.3.0

Local upgrade: in case the MR has no Internet connectivity, it's now possible to upgrade the MR
from local source

New Start panel interface on WebUI:

 new panel with 4 pages for the basic recording parameters 

 a new faster event list to see and download event and background files 
 some  advanced  event/background  settings  have  been  moved  in  a  new  panel:   User

Parameters > Recording setting 

VDV Cloud service on webui:

 simple panel where one just needs to enter a user name  and password 

FFT computation on event file:

 dominant frequencies are available in  XMR/ASCII file 

 show dominant frequencies in mail and SMS messages for event based alerting

Dynamic DNS servicethe available services are:

  dyndns,

  no-ip,

  ovh,

  dyndnsit,

  changeip,

  sitelutions 

FTP servicesPush service:

 send new events to FTP server as soon as  they are recorded 

 send background file to the FTP server each time it's  updated (see below);

 option to preserve/discard the SD-Card hierarchy on  the FTP server. 

 add configuration on page System > FTP Send 

Change FTP service:

 "FTP sync" is replaced by "FTP backup" terminology 
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 add test button on page System > FTP send to check  the FTP client configuration 

 improve stability and resiliency 

Change Event list by Recording list on the WebUI 

Improve power consumption:

 disable ethernet PHY if there isn't a cable connected  to the LAN port 

Improve boot time:

 database building at startup is now around  20 times faster 

Improve alerting:

 vector sum is now displayed in mail and SMS messages for event based alerting

 Alarm based alerting upon exceedance of the alarm thresholds 

 the option "wait for at least" has been removed as it has become obsolete

Change Timed recording service:

 add timed recording status on Status page 

 move timd erecording configuration from User > Record to new User > Timed recording
page 

 change timed recording configuration parameters to be better understadable to everyone 

 improve the accuracy of the record start time 

Change LAN configuration:

 add a new parameter to be able to continue DHCP request until IP has been received or
fallback to a static IP address after some failure requests 

Change event and background filenames on SD Card. The new format is  <Year/2 digits><Day of
year/3 dig.><A number/3 or more dig.>.EXT

Change  files  organization  in  zip  file  downloaded  from the  recording  list.  The  files  are  divided
between 2 directories:  events/ and background/

Change SMS message behavior:

 add date and time for events and alarm in all cases 

Improve background recording on SD card:

 write background file each period (or every 1 min. if  period < 1 min.) to prevent losing data

Change trigger status behavior on  Status page. This status is now independent of other kind of
recordings 

Improve stability when the MR is overloaded of triggered events 

Add OpenVPN file status on System > OpenVPN page 

Add NTP (network time protocol) status on Status and  System > Time page 
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ASCII file format:

 timestamps show microseconds instead of milliseconds 

 file can be viewed with the standard notepad  on Windows 

6.2 1.3.0 > 1.3.1

Bug fix ftp send service when change the MR name.Force a restart to take care of this new name 

Bug fix background service issue which can occur during its initialization 

Improve  flexibility  of  the  ftp  send  configuration.  If  the  host  setting  contains  subdirectory  (eg.
myftpser/mydir), it will be automatically created on the ftp server if it doesn't exist.

6.3 1.3.1 > 1.3.2

rename  page  "SYSTEM  >  DIAGNOSTIC"  into  "SYSTEM  >  MAINTENANCE"  and  add  a  new
section on this page with a reboot button ; 

fix warning messages refresh on page "USER PARAMETERS > CONTACTS" ; 

add cleanup process at boot to remove old filesystem check logs to save disk space on SD-card 

improve resilience of the upgrade procedure by stopping some processes which can interfere with
it 

fix the recording number in XMR and BMR 

increase  timeout  value  on  upgrade  procedure  on  web  otherwise  some  customers  with  bad
connection throughput can experiment some troubles.
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Appendix A: Internet access for the MR
We often talk about the MR having an Internet access on this manual, so let's clarify this point a
little bit.

First, why should the MR have an Internet access ? Well, there are various reasons:

 some services, like NTP time synchronization, or FTP synchronization, can't work without
that.

 if the MR is out in the field (so basically, when you're not configuring but using it), you
can't reach it from your office unless the MR has Internet access.

Now, how to have Internet access ? If you read carefully the previous sections, you noticed that
there are two ways to achieve that:

 through the Ethernet interface.

 through the radio packet service of the mobile GSM / UMTS network (GPRS/EDGE, or
HSPA)

You also remember that you can't use these two modes together (see the note in chapter 4.3.5).

How to test if the MR can access the Internet? There is a ping button in the WebUI (see chapter
4.3.12). A ping is basically a request sent to a Web site, to check if it's available. It's a common way
to see whether you can reach Internet: if you can ping a Web site, you're connected to Internet.

Now, what does really mean “having an Internet access” ? That's a little bit more complicated that it
seems. When a MR accesses the Internet, it's a little bit like if it was in a bubble: the LAN (or Local
Area Network). From this bubble, the MR can reach the outside world (Internet) and e.g. push data
to the FTP server, but you can't reach the MR from the outside world. We don't want to enter into
thorough explanations about the WHY you can't reach it.  It's a question of IP addresses, deep
understanding of what is a LAN, and other technical details that are not subject of this manual. 

To reach the MR from the outside world you additionally need a software that will allow you to
communicate with the MR. OpenVPN is such a software, and Dynamic DNS (DDNS) is another,
both are implemented as services in the MR.

Let's discuss three possible scenarios:

1. You use an existing ADSL or Cable-TV router in a private house. Typically such a router offers
the following features:

 share  a  single  Internet  connection  (i.e.  a  single  public  and  in  most  cases  dynamic  IP
address) to different devices connected via Ethernet cable and/or Wi-Fi connection. 

 DHCP server to automatically configure the network settings of the attached devices – we
assume DHCP is active.

Result:

FTP push service and the NTP service work nicely,  but you can not reach the MR to change
parameters. By activating the OpenVPN service, access form the outside world is possible without

14111000_MR3000-4.39.odt  printed: 03/01/14  subject to technical change without notice



SYSCOM

any additional  settings.  To make use of  DDNS you have to change the settings  of the router
(activate port-forwarding). 

The use of the WLAN hot-spot offered by the router is not possible, as the MR does not offer a Wi-
Fi client service.

2. You use the GPRS service with an ordinary SIM card:

The MR acquires a private (not accessible from the outside world) and dynamic (changing often) IP
address.

Result:

FTP push service and the NTP service work nicely,  but you can not reach the MR to change
parameters. By activating the OpenVPN service, access form the outside world is possible without
any additional settings. The use of DDNS is not possible.

3. You use the GPRS service with a special SIM card (providing a public IP address):

The MR acquires a public (accessible from the outside world) and dynamic (changing often) IP
address.

Result:

FTP push service and the NTP service work nicely,  but you can not reach the MR to change
parameters.  By  activating  either  the  OpenVPN service  or  the  DDNS service,  access  form the
outside world is possible without any additional settings. 

Document history:

4.36 all pictures embedded

4.37 Cross-references updated

4.38 Comments by Anthony integrated – new screenshots firmware 1.3.2

4.39 Comments by Joël integrated – Appendix rewritten

14111000_MR3000-4.39.odt  printed: 03/01/14  subject to technical change without notice


	1. INTRODUCTION
	1.1 Features
	1.2 Applications

	2. HARDWARE
	2.1 Mechanical Drawing – Overview
	2.2 Connectors
	2.2.1 Power
	2.2.2 LAN
	2.2.3 GPS

	2.3 Display (LCD)
	2.4 Status LEDs
	2.5 Opening the Lid
	2.5.1 GSM module
	2.5.2 SD-card
	2.5.3 Internal backup-battery
	2.5.4 Velocity Sensor

	2.6 Battery pack (optional)

	3. SET-UP of the MR3000
	3.1 Connecting to the MR3000 for the first time (direct connection)
	3.1.1 Wireless connection
	3.1.2 Wired connection via Router
	3.1.3 Wired connection without router

	3.2 Connecting to the MR3000 in the field (remote connection)

	4. The Web User Interface (WebUI)
	4.1 Start
	4.1.1 Manual recording
	4.1.2 Trigger recording
	4.1.3 Timed recording
	4.1.4 Background recording

	4.2 Status
	4.3 System
	4.3.1 SD-Card
	4.3.2 Time
	4.3.3 LAN
	4.3.4 Wi-Fi
	4.3.5 Mobile
	4.3.6 DDNS
	4.3.7 OpenVPN
	4.3.8 Mail
	4.3.9 FTP send
	4.3.10 VDV Cloud
	4.3.11 Authentication
	4.3.12 Upgrade
	4.3.13 Maintenance

	4.4 User Parameters
	4.4.1 General
	4.4.2 Contacts
	4.4.3 Alarm
	4.4.4 Daily message
	4.4.5 Acquisition
	4.4.6 Recording setting

	4.5 VIEW
	4.5.1 Acquisition
	4.5.2 Background

	4.6 Recording List

	5. OPERATING THE MR3000
	5.1 Preparing the MR for field use
	5.1.1 Construction site monitoring
	5.1.2 Single day measurement

	5.2 Power Options
	5.2.1 External 12 VDC Battery
	5.2.2 Battery Pack
	5.2.3 External AC/DC Power Supply
	5.2.4 Power over Ethernet
	5.2.5 Combined Power Options

	5.3 Additional services
	5.3.1 Embedded SFTP server.
	5.3.1.1 FireFTP
	5.3.1.2 Filezilla
	5.3.1.3 WinSCP



	6. Firmware history
	6.1 Firmware 1.3.0
	6.2 1.3.0 > 1.3.1
	6.3 1.3.1 > 1.3.2


